
RELEASE NOTES RELEASE NOTES 
 

N4917BSCB 400G Optical Receiver 

Test Application 
This document contains the latest information on the Keysight N4917BSCB 400G Optical Receiver 

Test Application. 

The N4917BSCB 400G Optical Receiver Test Application succeeds the earlier N4917BSCA 400G 

Optical Receiver Test Application with the difference that the N4917BSCB software has majorly 

transitioned to a new licensing model, in addition to the Enhancements listed in this document. 

 

Related Document 

For detailed information, refer to the following document for this application:  

- “Keysight_N4917BSCB_UserGuide.pdf” 

This document can be found at the following location after you install the application: 

C:\Program Files\ Keysight\M8070B\Apps\N4917BSCB\help  

The M8070B documents can be located by clicking Start > All Programs > Keysight M8070B > 

Keysight M8070B Documentation. Alternatively, you can also visit 

www.keysight.com/find/m8070b to find the latest versions of M8070B document

http://www.keysight.com/find/m8070b
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Installation Steps 

To install the N4917BSCB 400G Optical Receiver Test Application, perform the following steps: 

1. Review the System Requirements for this application. 

2. Download the installer file from:  

http://www.keysight.com/find/N4917BSCB 

3. Double-click the downloaded installer file on your PC. 

4. Follow and respond to the installer’s prompts. 

5. Accept the terms of the Keysight Software End-User License Agreement and click Next. 

6. Click Install. 

7. Click Finish to finish the installation and exit the installation wizard. 

8. Install the required licenses via the Keysight License Manager (if not done before). To know 

about the required licenses, refer to the Data Sheet. 

Getting Started 

To access the installed N4917BSCB application, perform the following steps: 

1. From the Start menu of the Windows Operating System, select All Programs > Keysight 

M8070B Applications > Launch Keysight N4917BSCB. 

2. If you are launching the Keysight N4917BSCB application for the first time, the End-User 

License Agreement window appears. Select Agree to continue. 

The N4917BSCB application banner is displayed. 

3. If there is a single instance of the M8070B software running locally, the N4917BSCB 

application launches after automatically getting connected to the M8070B software.  

4. If the N4917BSCB application does not detect any instance of the M8070B software 

running locally, the Connect to M8070 window appears. 

5. When the application starts successfully, it will start with the default layout and will show 

the Set Up tab. 

For more information on how to use the various features in the N4917BSCB application, 

refer to the Keysight N4917BSCB 400G Optical Receiver Test Application Online Help. 

http://www.keysight.com/find/N4917BSCB
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Keysight N4917BSCB Software Version 3.6.0 

Released Date:  August, 2025 

Operating System:  Microsoft Windows 10 
Microsoft Windows 11 

Memory  8 GB RAM [minimum]  

Display resolution:  WXGA+ (1440 x 900) [minimum]  

PC Interfaces  USB  

LAN  
GPIB (optional)  

Instrument Firmware  M8040A BERT - M8070B System Software. For the 

supported versions see the Software Pre-requisites 
row.  

DCA-M/DCA-X - FlexDCA version version A.07.61.12 
or later  

8164B LMS - Ver.V5.25 or later  
8149xA Ref Tx - Ver.5.01 or later  

BERT  M8070B system software 11.6.20.2 
M8040A-BU2 mainframe with USB option  

M8045A-G32/G64*/0G3/0G4/0P3/801 High 

Performance BERT module (driver v11.6.8.1) 
M8057A Remote head for M8045A pattern 

generator, 1 channel  
M8046A-A32/0P3*/801 Analyzer module (driver 

v11.6.8.1) 
M8043A-A32/A64*/0A3 Analyzer module 

(driver   v4.5.6.2) 

Signal Generator for Sinusoidal and 
Gaussian Noise Interference  

M8195A-002/16G Arbitrary Waveform Generator 
driver v11.6.8.1) or  

M8196A-002 Arbitrary Waveform Generator (driver 
v11.6.8.1) or  

M8054A Interference Source, 32 GHz (driver 
v.4.4.1.0) 

Lightwave Measurement System  8164B LMS Mainframe  
Tunable lasers   

N7779C Step-Tunable Laser Source, High Power and 

Low SSE, Basic Line or   
N7776C Tunable Laser 1240-1380 nm or  

N7778C Tunable Laser 1240-1380 nm or  
81602A-013 Tunable Laser 1250-1370 nm or  

81606A-113 Tunable Laser 1240-1380 nm or  
81608A-113 Tunable Laser 1240-1380 nm or  

81609A-113 Tunable Laser 1240-1380 nm  
  

Reference Transmitters  

81490A-E05 Reference Transmitter or   
81490A-E09 Reference Transmitter or  
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81490A-E10 Reference Transmitter (multimode – for 
SR only)  

81491A-085* Reference Transmitter (multimode - for 
SR only)  

81491A-135 Reference Transmitter  
81492A-E01* Reference Transmitter  

81492A-135* Reference Transmitter (56GBaud)  

  
N7718C-E13 Reference Transmitter  

N7718C-313 Reference Transmitter  
 

81000FI Optical Connector Interface  
81000NI Optical Connector Interface  

  
Optical attenuators:   

N7752C 2-Channel Optical Attenuator and Power 
Meter or    

N7764C 4-Channel Optical Attenuator or   

81576A Attenuator module (straight SMF) or  
81577A Attenuator module (angled SMF) or  

N7761A external Attenuator (1 ch straight SMF) or  
N7762A external Attenuator (2 ch straight SMF) or  

N7764A external Attenuator (4 ch straight SMF)  
N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) or  
N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF)  

N7768C Four-Channel Multimode Optical Attenuator 
or   

N7766A Optical Attenuator for Multimode Fiber (2ch) 
or   

N7768A Optical Attenuator for Multimode Fiber 
(4ch)   

DCA-X Oscilloscope  N1000A DCA-X Wide-Bandwidth mainframe 

N1000A-LOJ Low Jitter Timebase 
N1000A-PLK Pattern Lock Trigger Hardware 

N1000A-PTB Internal Precision Timebase 
N1030A/B Optical plug-in module 

DCA-M Oscilloscope  N1092A one optical channel or  
N1092B two optical channels or  

N1092C one optical, two electrical channels or  
N1092D four optical channels or  

N1092E two optical, two electrical channels  

options LOJ/PLK/IRC/200/300/500  

Clock Recovery  N1078A Optical/Electrical Clock Recovery  

N1077A-232/SMS/JSA Optical/Electrical Clock 
Recovery  

N1076A/B-Electrical Clock Recovery  
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Software Pre-requisites:  Keysight IO Library Version: 21.1.17.0 
M8070B system software for M8000 series ver. 

11.6.20.2 or later and  
M8070ADVB Advanced Measurement Package for 

M8000 series Version 1.13.220.14 
N1010A FlexDCA Remote Access System A.07.61.12 

with N1010100A R&D Package  

  

Application Requirements:  Keysight M8070B System Software Version. For the 

required licenses, see User Guide.  
Keysight N4917BSCB 400G Optical Receiver Test 

Application. For the required licenses, see User 
Guide.   

File Name:  SetupN4917BSCB_IEEE400GORSTApp_3.6.0.0.exe 

License:  Please see the product data sheet on keysight.com   

Note: the options highlighted bold* are required to address speed above 32Gbaud 

New Features 

- Added support for N7718C Reference transmitters. 

- Added support for M8043A Error Analyzer. 

- Introduced a new utility function to recall only BERT PG and SI settings without requiring a 

connection to the DCA and optical devices. 

- Enabled stressed eye calibration without the use of an optical attenuator (OMA adjustment 

skipped)  

- Added an option to inject a fixed amount of BUJ and RJ to the test signal before iSECQ 

tuning. 

Fixed Issues 

- DCI works only when an error detector module is detected. 

- Calibration does not complete successfully when using GN only on M8054A or M8196A as 

interference source. 

Known Issues 

- When opening the application’s user guide in the Acrobat Reader PDF Viewer from within 

the N4917BSCB application (Help → View Test Procedure), error pop-up messages have 

been observed in some cases. To view the PDF document in this case, please follow one of 

the following workarounds: 

o Open the PDF document directly from with the Acrobat Reader application either 

by browsing to the installation location “c:\Program 

Files\Keysight\M8070B\Apps\N4917BSCB\help\” or downloading the file from 

Keysight.com 
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o Change the default file viewer program for PDF files in Windows to different 

software, e.g., Microsoft Edge. 

- Saved projects files from previous versions (< 3.0.0) cannot be opened anymore due to the 

change of the application name. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

RF attenuator might be required in the interference signal (SI + GN) path. Use this 

approach when the calibration fails, and an error related to clipping of AWG amplitude is 

reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB 

User Guide. 

- During the installation of N4917BSCB Rev.3.0, a command window showing several 

“Access denied” messages might be visible. These messages are caused by internal 

installation processes and can be ignored and do not affect the installation success. 

- The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be 

measured during the stress receiver signal calibration on the (TDECQ) filtered channel. 

Though the measurement results will mainly be the same as if measured on the unfiltered 

channel, this configuration might be changed in future release versions.  

- The N4917BSCB software will automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using the following configuration variables: 

o SI attenuator (true/false), Gaussian Noise attenuator (true/false) 

o SI channel attenuation, GN channel attenuation available in “Debug Mode” under 

Configure (tab) -> Stress receiver signal calibration. 

 

In case different attenuation values for SI and GN channel are used, the same 
configuration variables can also be used to shift the usable sinusoidal interferer to noise 

ratio (“SIGNRatio”) to larger or smaller values. 
 

Exemplary calculation: 

SI attenuation: 10dB, GN attenuation: 10dB  -> SI to GN range: -13dB .. +17dB 

SI attenuation: 10dB, GN attenuation: off  -> SI to GN range: -23dB .. +7dB 

SI attenuation: off, GN attenuation: 10dB  -> SI to GN range: -3dB .. +27dB 

 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). 
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- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BSCB application, timeout errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

- Baudrates other than 26.5625 and 53.125 Gbd may not be supported when sinusoidal 

interference (SI) is injected in the stress signal 

- GN calibration only (i.e. disabling SI generator) works only if the “channel 1” of the 

interference source is used for GN (for M8054A and M8196A) 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if 

you encounter any other issue. 

 

 

 

 

http://www.keysight.com/find/supportrequest
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Keysight N4917BSCB Software Version 3.5.27 

Released Date:  July 25, 2024  

Operating System:  Microsoft Windows 10 
Microsoft Windows 11 

Memory  8 GB RAM [minimum]  

Display resolution:  WXGA+ (1440 x 900) [minimum]  

PC Interfaces  USB  

LAN  
GPIB (optional)  

Instrument Firmware  M8040A BERT - M8070B System Software. For the 

supported versions see the Software Pre-requisites row.  
DCA-M/DCA-X - FlexDCA version A.07.50.258 or later  

8164B LMS - Ver.V5.25 or later  
8149xA Ref Tx - Ver.5.01 or later  

BERT  M8040A-BU2 mainframe with USB option  
M8070A-0TP/ONP/1TP/1NP System Software. For the 

complete list of licenses for M8070B, see Chapter 2 of the 
User Guide.  

M8045A-G32/G64*/0G3/0G4/0P3/801 High Performance 

BERT module  
M8057A Remote head for M8045A pattern generator, 1 

channel  
M8046A-A32/0P3*/801 Analyzer module  

Signal Generator for Sinusoidal and 
Gaussian Noise Interference  

M8195A-002/16G Arbitrary Waveform Generator or  
M8196A-002 Arbitrary Waveform Generator or  

M8054A Interference Source, 32 GHz  

Lightwave Measurement System  8164B LMS Mainframe  
Tunable lasers   

N7779C Step-Tunable Laser Source, High Power and Low 
SSE, Basic Line or   

N7776C Tunable Laser 1240-1380 nm or  
N7778C Tunable Laser 1240-1380 nm or  

81602A-013 Tunable Laser 1250-1370 nm or  
81606A-113 Tunable Laser 1240-1380 nm or  

81608A-113 Tunable Laser 1240-1380 nm or  

81609A-113 Tunable Laser 1240-1380 nm  
  

Reference Transmitters  
81490A-E05 Reference Transmitter or   

81490A-E09 Reference Transmitter or  
81490A-E10 Reference Transmitter (multimode – for SR 

only)  
81491A-085* Reference Transmitter (multimode - for SR 

only)  

81491A-135 Reference Transmitter  
81492A-E01* Reference Transmitter  
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81492A-135* Reference Transmitter (56GBaud)  
  

81000FI Optical Connector Interface  
81000NI Optical Connector Interface  

  
Optical attenuators:   

N7752C 2-Channel Optical Attenuator and Power Meter 

or    
N7764C 4-Channel Optical Attenuator or   

81576A Attenuator module (straight SMF) or  
81577A Attenuator module (angled SMF) or  

N7761A external Attenuator (1 ch straight SMF) or  
N7762A external Attenuator (2 ch straight SMF) or  

N7764A external Attenuator (4 ch straight SMF)  
N7751A external Attenuator (1 ch with 2 optical power 

meter channels, SMF) or  
N7752A external Attenuator (2 ch with 2 optical power 

meter channels, SMF)  

N7768C Four-Channel Multimode Optical Attenuator or   
N7766A Optical Attenuator for Multimode Fiber (2ch) or   

N7768A Optical Attenuator for Multimode Fiber (4ch)   

DCA-X Oscilloscope  N1000A DCA-X Wide-Bandwidth mainframe  

86100D-ETR/PTB/200/300 DCA-X mainframe  
  

N1030A/B Optical plug-in module for the N1000A DCA-X 

mainframe  
86105D-281/IRC Electrical/Optical SMF module or  

86115D-282 /IRC Dual Optical SMF module  
  

86107A-020 Precision Time Base (not required, if DCA-X 
has the option –PTB)  

DCA-M Oscilloscope  N1092A one optical channel or  
N1092B two optical channels or  

N1092C one optical, two electrical channels or  

N1092D four optical channels or  
N1092E two optical, two electrical channels  

options LOJ/PLK/IRC/200/300/500  

Clock Recovery  N1078A Optical/Electrical Clock Recovery  

N1077A-232/SMS/JSA Optical/Electrical Clock Recovery  
N1076A/B-Electrical Clock Recovery  

Software Pre-requisites:  Keysight IO Library rev. 18.2 or above  

M8070B system software for M8000 series ver. 11.0.60.4 
or later and  

M8070ADVB Advanced Measurement Package for M8000 
series ver. 1.3.200.4 

N1010A FlexDCA Remote Access System A.07.50.258 or 
later  
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In the newer releases of FlexDCA, analysis packages that 
combine many separate items that were available 

previously under individual licenses are now available. 
Refer to the Data Sheet to see how features of previous 

FlexDCA releases map into the more recent FlexDCA 
packages. For the N4917BSCB 400G Optical Receiver Test 

Application, you require the following analysis package:  

• N1010100A R&D Package  
  

Alternatively, use the older licenses:  
• N1010A-9FP (PAM-N Analysis Software)  

• N1010A-TFP (TDECQ Transmitter and Dispersion 
Eye Closure for PAM4)  

Application Requirements:  Keysight M8070B System Software Version. For the 
required licenses, see User Guide.  

Keysight M8045A with options G32 or G64; 03G or UG3; 

0G4 or UG4; 0P3 or UP3 or 0P6 or UP6  
Keysight M8046A with options A32 or A64; 0P3 or UP3  

Keysight N4917BSCB 400G Optical Receiver Test 
Application. For the required licenses, see User Guide.   

File Name:  SetupM80RxIEEE400G00305027.exe  

License:  Please see the product data sheet on keysight.com   

 

New Features 

- Add support for N7752C, N7764C and N7768C optical attenuators 

Fixed Issues 

- Fix: can't run calibration with 8164B unless a TLS is plugged in 

- Fix: PAM4 / NRZ PRBS sequences not working in config tab 

Known Issues 

- When opening the application’s user guide in the Acrobat Reader PDF Viewer from within 

the N4917BSCB application (Help → View Test Procedure), error pop-up messages have 

been observed in some cases. To view the PDF document in this case the, please follow 

one of the following workarounds: 

o Open the PDF document directly from with the Acrobat Reader application either 

by browsing to the installation location “c:\Program 

Files\Keysight\M8070B\Apps\N4917BSCB\help\” or downloading the file from 

Keysight.com 

o Chance the default file viewer program for PDF files in Windows to a different 

software, as e.g., Microsoft Edge. 
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- Saved projects files from previous versions (< 3.0.0) cannot be opened anymore due to the 

change of the application name. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

RF attenuator might be required in the interference signal (SI + GN) path. Use this 

approach when the calibration fails, and an error related to clipping of AWG amplitude is 

reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB 

User Guide. 

- During the installation of N4917BSCB Rev.3.0, a command window showing several 

“Access denied” messages might be visible. These messages are caused by internal 

installation processes and can be ignored and do not affect the installation success. 

- The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be 

measured during the stress receiver signal calibration on the (TDECQ) filtered channel. 

Though the measurement results will mainly be the same as if measured on the unfiltered 

channel, this configuration might be changed in future release versions.  

- The N4917BSCB software will automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using the following configuration variables: 

o SI attenuator (true/false), Gaussian Noise attenuator (true/false) 

o SI channel attenuation, GN channel attenuation available in “Debug Mode” under 

Configure (tab) -> Stress receiver signal calibration. 

 

In case different attenuation values for SI and GN channel are used, the same 

configuration variables can also be used to shift the usable sinusoidal interferer to noise 
ratio (“SIGNRatio”) to larger or smaller values. 

 

Exemplary calculation: 

SI attenuation: 10dB, GN attenuation: 10dB  -> SI to GN range: -13dB .. +17dB 

SI attenuation: 10dB, GN attenuation: off  -> SI to GN range: -23dB .. +7dB 

SI attenuation: off, GN attenuation: 10dB  -> SI to GN range: -3dB .. +27dB 

 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BSCB application, timeout errors might occur. 
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To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

- Baudrates other than 26.5625 and 53.125 Gbd may not be supported when sinusoidal 

interference (SI) is injected in the stress signal 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if 

you encounter any other issue. 

  

http://www.keysight.com/find/supportrequest
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Keysight N4917BSCB Software Version 3.5.3 

Release Date:  September 18, 2023 

File Name: SetupM80RxIEEE400G03050003.exe 

Operating System Microsoft Windows 7, Windows 8, Windows 10, (64 bit) 

Requirements Category  

(e.g., instrument software version): 

Please see the product data sheet on keysight.com 

License: Please see the product data sheet on keysight.com 

 

New Features 

- Added support for the following new transmission standard: 

o IEEE 802.3db 100G/Lambda Multimode. 

- Support for N7779C tunable lasers. 

- Improved PAM4 linearity optimization algorithm for better results at high optical extinction 

ratios (ER), which could drive the E/O modulator in its non-linear regime. 

Other changes 

- The default “ISI optimization” method used for all transmission standards has been 

changed to “Method 3” which uses an improved readjustment algorithm that gives the 

best ISI calibration results for all transmission standards. 

Fixed Issues 

- Fixed a defect that caused the stress eye calibration to stop with an exception when the 

DCA measurement clipped hi or low. 

- Fixed a defect that caused the software to stop with an exception when capturing the DCA 

stressed eye screenshot from a high-resolution monitor. 

- Fixed a defect that inhibited the software from using the second internal laser source 

(1550nm) in the reference transmitter modules 8194xA. 

- Fixed a defect in the calibration result PDF export.  

- Fixed a defect in the calibration result CSV export. 
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Known Issues 

- When opening the application’s user guide in the Acrobat Reader PDF Viewer from within 

the N4917BSCB application (Help → View Test Procedure), error pop-up messages have 

been observed in some cases. To view the PDF document in this case the, please follow 

one of the following workarounds: 

o Open the PDF document directly from with the Acrobat Reader application either 

by browsing to the installation location “c:\Program 

Files\Keysight\M8070B\Apps\N4917BSCB\help\” or downloading the file from 

Keysight.com 

o Chance the default file viewer program for PDF files in Windows to a different 

software, as e.g., Microsoft Edge. 

- Saved projects files from previous versions (< 3.0.0) cannot be opened anymore due to the 

change of the application name. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

RF attenuator might be required in the interference signal (SI + GN) path. Use this 

approach when the calibration fails, and an error related to clipping of AWG amplitude is 

reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB 

User Guide. 

- During the installation of N4917BSCB Rev.3.0, a command window showing several 

“Access denied” messages might be visible. These messages are caused by internal 

installation processes and can be ignored and do not affect the installation success. 

- The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be 

measured during the stress receiver signal calibration on the (TDECQ) filtered channel. 

Though the measurement results will mainly be the same as if measured on the unfiltered 

channel, this configuration might be changed in future release versions.  

- The N4917BSCB software will automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using the following configuration variables: 

o SI attenuator (true/false), Gaussian Noise attenuator (true/false) 

o SI channel attenuation, GN channel attenuation available in “Debug Mode” under 

Configure (tab) -> Stress receiver signal calibration. 

 

In case different attenuation values for SI and GN channel are used, the same 

configuration variables can also be used to shift the usable sinusoidal interferer to noise 
ratio (“SIGNRatio”) to larger or smaller values. 
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Exemplary calculation: 

SI attenuation: 10dB, GN attenuation: 10dB  -> SI to GN range: -13dB .. +17dB 

SI attenuation: 10dB, GN attenuation: off  -> SI to GN range: -23dB .. +7dB 

SI attenuation: off, GN attenuation: 10dB  -> SI to GN range: -3dB .. +27dB 

 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BSCB application, timeout errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if 

you encounter any other issue. 

http://www.keysight.com/find/supportrequest
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Keysight N4917BSCB Software Version 03.00.0050 

Release Date:  April 05, 2023 

File Name: SetupM80RxIEEE400G03000050.exe 

License: Please see the product data sheet on keysight.com 

 

The system requirements for the N4917BSCB application remain the same as for the previous 

release. See system requirements.  

Modification 

- Update with Keysight License Manager 5 

Known Issues 

- See Known Issues. 

 

Keysight N4917BSCB Software Version 03.00.0014 

Release Date:  January 14, 2022 

File Name: SetupM80RxIEEE400G03000014.exe 

License: Please see the product data sheet on keysight.com  

 

The system requirements for the N4917BSCB application remain the same as for the previous 

release. See system requirements.  

Fixed Issues 

- Fixed a defect that caused the software to not to recognize the connected multi-mode 

attenuators (N7766 and N7768) correctly when choosing the transmission standard 

“50G/100G/200G/400G-SR IEEE 802.3cd”. 

- Fixed a defect that caused the software to set a wrong clock divider for the DCA-M scope 

when using a recovered clock instead of the clean clock during the stress signal 

calibration. 

- Fixed a defect that caused the stress signal calibration to abort during the BERT 

deemphasis coefficient optimization when using a recovered clock. 

- Fixed a defect that caused the software to abort the RX sensitivity test when using the 

M8070 DUT Control Interface (DCI) due to a missing initialization step. 
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- Fixed a defect that caused the software to not update some standard settings when 

loading a saved project file or restoring the project settings after an unexpected software 

crash. 

- Adjusted the notation of measurement units in the results tables (added spaces between 

the result value and unit in some cases).  

- Added new choice (“Method 3”) for the configuration variable “ISI Generation method” that 

is a slightly modified variant of “Method 2” that readjusts the ER during iteration to prevent 

a large initial SECQ excess. 

 

Other changes 

- Added a new configuration variable “TDECQ Filter Preset” (available in debug mode) that 

allows you to specify a different from the standard TDECQ Reference Equalizer preset (in 

the FlexDCA software) to be used for the stress signal calibration. 

 

Known Issues 

- See Known Issues. 

 

Keysight N4917BSCB Software Version 03.00.0004 

Release Date:  December 16, 2020 

File Name: SetupM80RxIEEE400G03000004.exe 

License: Please see the product data sheet on keysight.com  

 

The system requirements for the N4917BSCB application remain the same as for the previous 

release. See system requirements.  

 

Fixed Issues 

- Fixed a defect that would cause the stress signal calibration to abort when using a N777xC 

class tunable laser as optical source. 

- Fixed a defect that would cause the N4917BSCB application started in demo mode 

(“Launch Keysight N4917BSCB (Demo)” option in the Start menu) to shut down with an 

exception.  

 



 

 
Keysight N4917BSCB 400G Optical Receiver Test Application Release Notes  18 / 39 

Known Issues 

- See Known Issues. 

 

Keysight N4917BSCB Software Version 03.00.0002 

The following table lists the supported hardware and firmware for the N4917BSCB application. An 

“*” (asterisk) and bold text in this section indicates options required for 53.125 GBaud-based 

standards. 

 

Released Date: October 9, 2020 

Operating System: Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution: WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070B System Software. For the 

supported versions see the Software Pre-requisites 

row. 

DCA-M/DCA-X - FlexDCA version A.06.60.378 or 

later 

8164B LMS - Ver.V5.25 or later 

8149xA Ref Tx - Ver.5.01 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software. For 

the complete list of licenses for M8070B, see 

Chapter 2 of the User Guide. 

M8045A-G32/G64*/0G3/0G4/0P3/801 High 

Performance BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/0P3*/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 

M8054A Interference Source, 32 GHz 
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Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

N7776C Tunable Laser 1240-1380 nm or 

N7778C Tunable Laser 1240-1380 nm or 

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

81491A-085 Reference Transmitter (multimode - 

for SR only) 

81491A-135 Reference Transmitter 

81492A-E01* Reference Transmitter 

81492A-135* Reference Transmitter (56GBaud) 

  

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 

N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

8490D-010 - Coaxial Fixed Attenuator, DC to 50 

GHz 
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DCA-X Oscilloscope N1000A DCA-X Wide-Bandwidth mainframe 

86100D-ETR/PTB/200/300 DCA-X mainframe 

 

N1030A/B Optical plug-in module for the N1000A 

DCA-X mainframe 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/300/500 

Clock Recovery N1078A Optical/Electrical Clock Recovery 

N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

N1076A/B-Electrical Clock Recovery 

Software Pre-requisites: Keysight IO Library rev. 18.1 or above 

M8070B system software for M8000 series ver. 

7.2.40.2 or later and 

M8070ADVB Advanced Measurement Package for 

M8000 series ver. 1.3.200.4 

N1010A FlexDCA Remote Access System 

A.06.60.378 or later 

In the newer releases of FlexDCA, analysis 

packages that combine many separate items that 

were available previously under individual licenses 

are now available. Refer to the Data Sheet to see 

how features of previous FlexDCA releases map 

into the more recent FlexDCA packages. For the 

N4917BSCB 400G Optical Receiver Test 

Application, you require the following analysis 

package: 

• N1010100A R&D Package 

 

Alternatively, use the older licenses: 

• N1010A-9FP (PAM-N Analysis Software) 
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• N1010A-TFP (TDECQ Transmitter and 

Dispersion Eye Closure for PAM4) 

Application Requirements: Keysight M8070B System Software Version. For the 

required licenses, see User Guide. 

Keysight M8045A with options G32 or G64; 03G or 

UG3; 0G4 or UG4; 0P3 or UP3 or 0P6 or UP6 

Keysight M8046A with options A32 or A64; 0P3 or 

UP3 

Keysight N4917BSCB 400G Optical Receiver Test 

Application. For the required licenses, see User 

Guide.  

File Name: SetupM80RxIEEE400G00300002.exe 

License: Please see the product data sheet on keysight.com  

 

Enhancements 

- Support for the more recent Keysight tunable laser sources:  

o N7776C Tunable Laser 1240-1380 nm  

o N7778C Tunable Laser 1240-1380 nm 

- Support for the N1030A/B Optical plug-in modules for the N1000A DCA-X mainframe. 

- Support for the following new Interference source for sinusoidal interference and Gaussian 

noise in all the supported measurement flavors: 

o M8054A Interference Source, 32 GHz 

- Support for new firmware versions 

o M8070B - 7.2.40.2 

▪ M8070ADVB Advanced Measurement Package for M8000 Series - 1.3.200.4 

o FlexDCA - A.06.60.378 

o M8195A SFP – 4.0.0.0  

- Added the following new configuration variables: 

o Force Multichannel Attenuator Reset – By default, this configuration variable is set to 

“false”, which means that if you reset or turn off one channel of the connected 

multichannel attenuator, it does not cause a reset or turning off of the remaining 

channels.  

If set to “true”, a reset or turning off of one channel will reset/turn off all the channels 

in the multichannel attenuator. 

o DCA Screen Capture Mode – This variable enables you to choose which part of the 

DCA screen will be captured. The available choices include Display and Waveform. 
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Fixed Issues 

- The M8045A PG 64GBaud option (G64 or U64) has been removed as mandatory license 

option to run N4917BSCB application. When running N4917BSCB without a BERT PG 

64GBaud license option, compliance testing is now restricted to 26GBaud based 

transmission flavors. 

- Fixed the earlier behavior of the application causing all the channel of a connected 

multichannel attenuator to get reset or turned off when one channel was reset or turned 

off. A new configuration variable has been added for this. 

- The software now performs a check for the availability of the M8070ADVB package for 

M8070B and a valid license for using it, at the time of startup. This package is required for 

External CDR control, Jitter tolerance testing, and DUT control interface (DCI). 

- The Error Detector Compare Mode configuration variable now supports the following three 

values for the correct handling of M8046A error detector module: 

o Differential 

o Single Ended Normal 

o Single Ended Complement 

- Fixed an issue that would cause the N1078A clock data recovery to not to be recognized in 

the configuration during stress signal calibration. 

- Fixed an issue that prevented the correct loading of a previously saved project file  

- Fixed an issue because of which the calibrated value of Initial SECQ was being displayed 

the same as the final SECQ value in the Results view. 

 

Limitations 

- Limited support for the functionality of the “Upload Results to Repository” feature in the 

Test Application. 

 

Known Issues 

- Saved projects files from previous versions (< 3.0.0) cannot be opened anymore due to the 

change of the application name. To re-enable opening these projects files, the tags 

“Application name” in the main project file (*.proj) and compliance file (compliance.lim) in 

the project directory must be modified manually and should read the actual application 

name (see application window or name in project file saved with latest version). 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

RF attenuator might be required in the interference signal (SI + GN) path. Use this 

approach when the calibration fails, and an error related to clipping of AWG amplitude is 

reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB 

User Guide. 
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- When exporting calibration results as CSV file (File->Export Result…->CSV), the table 

containing the stressed eye calibration results is not contained in the created file. Please 

use the PDF or HTML file export instead. 

- During the installation of N4917BSCB Rev.3.0, a command window showing several 

“Access denied” messages might be visible. These messages are caused by internal 

installation processes and can be ignored and do not affect the installation success. 

- The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be 

measured during the stress receiver signal calibration on the (TDECQ) filtered channel. 

Though the measurement results will mainly be the same as if measured on the unfiltered 

channel, this configuration might be changed in future release versions.  

- The N4917BSCB software will automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using the following configuration variables: 

o SI attenuator (true/false), Gaussian Noise attenuator (true/false) 

o SI channel attenuation, GN channel attenuation 

available in “Debug Mode” under Configure (tab) -> Stress receiver signal calibration. 

 

In case different attenuation values for SI and GN channel are used, the same 

configuration variables can also be used to shift the usable sinusoidal interferer to noise 

ratio (“SIGNRatio”) to larger or smaller values 

 

Exemplary calculation: 

SI attenuation: 10dB, GN attenuation: 10dB  -> SI to GN range: -13dB .. +17dB 

SI attenuation: 10dB, GN attenuation: off  -> SI to GN range: -23dB .. +7dB 

SI attenuation: off, GN attenuation: 10dB  -> SI to GN range: -3dB .. +27dB 

 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BSCB application, timeout errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

 



 

 
Keysight N4917BSCB 400G Optical Receiver Test Application Release Notes  24 / 39 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue.  

 

Keysight N4917BSCB Software Version 02.50.0001 

The following table lists the supported hardware and firmware for the N4917BSCB application. An 

“*” (asterisk) and bold text in this section indicates options required for 53.125 GBaud-based 

standards. 

Release Date: June 28, 2019 

Operating System: Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution: WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070B/A System Software. For 

the supported versions see the Software Pre-

requisites row. 

DCA-M/DCA-X - FlexDCA version A.06.02.17 or 

later 

8164B LMS - Ver.V5.25 or later 

8149xA Ref Tx - Ver.5.01 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software. For 

the complete list of licenses for M8070B, see 

Chapter 2 of the User Guide. 

M8045A-G32/G64*/0G3/0G4/0P3/801 High 

Performance BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/0P3*/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator 

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

http://www.keysight.com/find/supportrequest
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81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter or 

81490A-E10 Reference Transmitter (multimode – 

for SR only) 

81491A-085 Reference Transmitter (multimode - 

for SR only) 

81491A-135 Reference Transmitter 

81492A-E01* Reference Transmitter 

  

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

N7766A Optical Attenuator for Multimode Fiber 

(2ch) 

N7768A Optical Attenuator for Multimode Fiber 

(4ch) 

8490D-010 - Coaxial Fixed Attenuator, DC to 50 

GHz 

DCA-X Oscilloscope N1000A DCA-X Wide-Bandwidth mainframe 

86100D-ETR/PTB/200/300 DCA-X mainframe 

 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 
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86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/300/500 

Clock Recovery N1078A Optical/Electrical Clock Recovery 

N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

N1076A/B-Electrical Clock Recovery 

Software Pre-requisites: Keysight IO Library rev. 18.1 or above 

M8070B system software for M8000 series ver. 

6.0.210.6 or later and 

M8070ADVB Advanced Measurement Package for 

M8000 series ver. 1.0.70.0 

OR 

M8070A system software for M8000 series ver. 

5.1.100.6 

N1010A FlexDCA Remote Access System 

A.06.02.17 or later 

In the newer releases of FlexDCA, analysis 

packages that combine many separate items that 

were available previously under individual licenses 

are now available. Refer to the Data Sheet to see 

how features of previous FlexDCA releases map 

into the more recent FlexDCA packages. For the 

N4917BSCB 400G Optical Receiver Test 

Application, you require the following analysis 

package: 

• N1010100A R&D Package 

 

Alternatively, use the older licenses: 

• N1010A-9FP (PAM-N Analysis Software) 

• N1010A-TFP (TDECQ Transmitter and 

Dispersion Eye Closure for PAM4) 

Application Requirements: Keysight M8070B/A System Software Version. For 

the required licenses, see User Guide. 
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Keysight M8045A with options G32 or G64; 03G or 

UG3; 0G4 or UG4; 0P3 or UP3 or 0P6 or UP6 

Keysight M8046A with options A32 or A64; 0P3 or 

UP3 

Keysight N4917BSCB 400G Optical Receiver Test 

Application. For the required licenses, see User 

Guide.  

File Name: SetupM80RxIEEE400G02500001.exe 

License: Please see the product data sheet on keysight.com  

 

Enhancements 

- Updated licensing model.  

o Support for USB portable/network licenses.  

o Subscription-based license options are now available for all the license types. 

For details, refer to https://literature.cdn.keysight.com/litweb/pdf/5992-3419EN.pdf. 

Alternatively, contact Keysight Technical Support. 

- Support for new optical IEEE 802.3cd (and relevant MSA) standards 

- 400G-SR8, 200G-SR4, 100G-FR, 100G-LR, 100GBASE-DR, 100G-SR2, 50GBASE-FR, 

50GBASE-LR, and 50GBASE-SR. Because of the similarities in their targets and 

implementation logic, the new multimode physical types (SR) are treated as a single 

category in the N4917BSCB application. 

- Support for “Noise Enhancement Factor” (Ceq) criterion and TX transition time 

measurement introduced in IEEE 802.3cd calibration procedure. 

- Support for new Keysight reference transmitter options: 81491A-135 and 81491A-085 

(multimode – for SR only). 

- Support for new Keysight N1000A DCA-X Wide-Bandwidth Oscilloscope Mainframe. 

- Support for new M8070B System Software for M8000 Series of BER Test Solutions. This 

also requires M8070ADVB Advanced Measurement Package for M8000 Series of BERT 

Test Solutions. 

- Support for new firmware versions 

o M8070B - 6.0.210.6 

▪ M8070ADVB Advanced Measurement Package for M8000 Series - 1.0.70.0 

o M8070A - 5.1.100.6 

o FlexDCA - A.06.02.17 

o M8195A SFP – 3.6  

- Enhanced initialization procedure for DUT Control Interface (DCI) to enable support for 

third-party error detectors. New configuration variables added for this purpose include: 

https://literature.cdn.keysight.com/litweb/pdf/5992-3419EN.pdf
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DUT Control Interface Location and DUT Control Interface Address (in addition to the 

existing DUT Control Interface Script File configuration variable). 

- Support for auxiliary VISA instruments, e.g. optical switch, to switch between the setups 

for calibration and testing. Two new configuration variables have been added for this 

purpose, Auxiliary Instrument VISA Address and Auxiliary Instrument SCPI Command. 

- Support for internal clock recovery in the newer M8046A error detector modules (requires 

corresponding license option). 

- Several usability enhancements 

o New configuration variable “Test Result Aggregation” to control whether the newer 

test results should replace or append to the existing test results, automatically, or if 

the application should prompt whether to replace or append the older test results with 

newer ones for each test run (default behavior). 

o New configuration variable “Jitter Tolerance CDR LBW Auto” to enable or disable the 

automatic loop bandwidth adjustment in case a clock data recovery (CDR) is used 

during jitter tolerance testing. This configuration variable is available in the Debug 

mode under the Configure tab. 

o TDECQ filter tabs are now reported in stress calibration results. 

- New configuration variable “Stress Signal Recall Pattern” to select which data pattern 

(SSPRQ or PRBS31Q) to use for the calibration file to be recalled. The default behavior of 

the application is to ask for the pattern during test execution. 

- Enhanced calibration file handling when switching between standards and reloading 

projects. 

- New configuration variables “Ceq target value” and “ISI generation method” in view of 

introduction of the IEEE 802.3cd transmission standards. 

- Several new configuration variables in the Debug mode under the Configure tab: 

Frequency Grid Mode, Frequency Increment Mode, Jitter Profile Frequency1, Jitter Profile 

Amplitude1, Jitter Profile Frequency2, Jitter Profile Amplitude2, Jitter Profile Frequency3, 

and Jitter Profile Amplitude3. 

Limitations 

- Limited support for the functionality of the “Upload Results to Repository” feature in the 

Test Application. 

Known Issues 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

RF attenuator might be required in the interference signal (SI + GN) path. Use this 

approach when the calibration fails, and an error related to clipping of AWG amplitude is 

reported (Error message: Set range clipped). See also note and figure 27 in N4917BSCB 

User Guide. 
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- When exporting calibration results as CSV file (File->Export Result…->CSV), the table 

containing the stressed eye calibration results is not contained in the created file. Please 

use the PDF or HTML file export instead. 

- During the installation of N4917BSCB Rev.2.5, a command window showing several 

“Access denied” messages might be visible. These messages are caused by internal 

installation processes and can be ignored and do not affect the installation success. 

- The outer extinction ratio (OER) and outer optical modulation amplitude (OOMA) will be 

measured during the stress receiver signal calibration on the (TDECQ) filtered channel. 

Though the measurement results will basically be the same as if measured on the 

unfiltered channel, this configuration might be changed in future release versions.  

- The N4917BSCB software will automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using the following configuration variables  

o SI attenuator (true/false), Gaussian Noise attenuator (true/false) 

o SI channel attenuation, GN channel attenuation 

available in “Debug Mode” under Configure (tab) -> Stress receiver signal calibration. 
 

In case different attenuation values for SI and GN channel are used, the same 

configuration variables can also be used to shift the usable sinusoidal interferer to noise 
ratio (“SIGNRatio”) to larger or smaller values 

 
Exemplary calculation: 

SI attenuation: 10dB, GN attenuation: 10dB  -> SI to GN range: -13dB .. +17dB 
SI attenuation: 10dB, GN attenuation: off  -> SI to GN range: -23dB .. +7dB 

SI attenuation: off, GN attenuation: 10dB  -> SI to GN range: -3dB .. +27dB 
 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the Configure tab). 

- When the Keysight N77xx Viewer software is connected via USB to a N77xx type 

attenuator which is also used by the N4917BACA application, time-out errors might occur. 

To prevent these errors during ORST testing, disconnect the N77xx Viewer software from 

the attenuator.  

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

 

http://www.keysight.com/find/supportrequest
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Keysight N4917BSCB Software Version 02.00.0002 

The following table lists the supported hardware and firmware for the N4917BSCA application. An 

“*” (asterisk) and bold text in this section indicates options required for 53.125 GBaud-based 

standards. 

Release Date: August 24, 2018 

Operating System: Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution: WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A System Software 

86100D DCA-X – N1010A FlexDCA version 

A.05.80.158 or later 

8164B LMS - Ver.V5.25 or later 

81490A Ref Tx - Ver.5.01 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software 

M8045A-G32/G64*/0G3/0G4/0P3/801 High 

Performance BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/0P3*/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator 

Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  
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81490A-E09 Reference Transmitter or 

81492A-E01* Reference Transmitter 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

8490D-010 - Coaxial Fixed Attenuator, DC to 50 

GHz 

DCA-X Oscilloscope 86100D-ETR/PTB/200/300 DCA-X mainframe 

 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/300/500 

Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

N1076A-Electrical Clock Recovery 

Software Pre-requisites: Keysight IO Library rev. 18.1 or above 

M8070A system software for M8000 series Ver. 

5.0.228.4 or later 

N1010A FlexDCA Remote Access System 

A.05.80.158 or later 
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N1010A-9FP (PAM-N Analysis Software) 

N1010A-TFP (TDECQ Transmitter and Dispersion 

Eye Closure for PAM4) 

Application Requirements: Keysight M8070A System Software Version: 

5.0.228.4 and above with options 0TP 

Keysight M8045A with options G32 or G64; 03G or 

UG3; 0G4 or UG4; 0P3 or UP3 or 0P6 or UP6 

Keysight M8046A with options A32 or A64; 0P3 or 

UP3 

Keysight N4917BSCA 400G Optical Receiver Test 

Application  

N4917BSCA-1FP or 1TP or 1NP or 1UP or 1FL or 

1TL or 1NL or 1UL  

File Name: SetupM80RxIEEE400G02000002.exe 

License: Please see the product data sheet on keysight.com  

 

Enhancements 

- Support for 53 GBd-based standards - 400GBASE-DR4, 400G-FR4 (Lambda MSA Group) 

- Full support for remote interface 

- Addition of two new utility functions: 

o Readjust reference transmitter power 

o Recall aggressor channel 

- Support for new reference transmitter 81492A-E01 (mandatory for all 53 GBd-based 

standards, but supports 26 GBd-based standards as well) 

- Support of new firmware versions 

o M8070 - 5.0.228.4 

o FlexDCA - A.05.80.158  

- Addition of new configuration parameters to support new 53 GBd-based standards and 

enhanced usability: REFTX Recalibration Threshold, Switch off PG during REFTX recal, 

Attenuator Settling Time, Optimize PAM4 Linearity, Skip receive power (OOMA) calibration, 

DCA Clock Source, Clock Data Recovery Module, PG ClockOut Divider, Pause before 

starting RX tests, Run ED Auto-Alignment before starting RX Tests, Error Detector 

Alignment Threshold, Recall Aggressor Channel, Aggressor Channel Source, Aggressor 

Channel Target, Error Detector Baud Rate, Error Detector Follow SYS Clock, Error Detector 

Timeout, Clock Data Recovery Source, and Clock Data Recovery Loop Bandwidth 

- Several usability enhancements 

o Generation of aggressor channel on second M8045A pattern generator output channel 

(if available) 
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Usage: 

The IEEE 802.3bs standard requires to use aggressor channels on all others than 

the RX channel under test, so the N4917BSCA software Rev 2.0 offers a new 

function to generate another electrical data output channel (if available in used 

M8045A module).  

The second data channel can automatically be configured during the start of a 

receiver test (Configure (tab) > Receiver Testing > Recall aggressor channel > true) 

or using the utility function “Recall aggressor channel”. As configuration source you 

can choose between the following settings (Configure (tab) > Receiver Testing > 

Aggressor Channel Source) 

▪ PG Channel   - Copies settings from PG channel to configure CH2 

▪ Current setting   -  Recalls current settings for CH2 after BERT reset 

▪ Configuration file - Uses XML configuration file from path: 

c:\ProgramData\Keysight\M8070A\Apps\N4917BSCA\Info\DefaultAggressorSettin

gs.xml  

o New optical power adjustment function to re-adjust the calibrated optical output 

power due to a reference transmitter operating point drift. 

Usage: 

The output power of the calibrated stress test signal must not change during RX 

conformance testing to ensure the specified and calibrated OMA level. A possible 

drift of the reference transmitter’s (REFTX) operation point would cause the output 

power to change thus the measured optical power at the output of the attenuator 

can be used to recalibrate the REFTX’s operation point. This can be done by using 

the new “Readjust reference transmitter power” utility function. 

o New configuration variable (Skip receive power (OOMA) calibration) to skip the final 

optical power adjustment during stressed RX signal calibration  

o Better organization of configuration parameters in logical groups 

 

Limitations 

- Limited support for the functionality of the “Upload Results to Repository” feature in the 

Test Application. 

 

Known Issues 

- Depending on the targeted standard and particular hardware configuration, a 6dB or 10dB 

attenuator might be required in the interference signal (SI + GN) path. Use this approach 

when the calibration fails, and an error related to clipping of AWG amplitude is reported 

(Error message: Set range clipped). 
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- The N4917BSCA software will use automatically use a reduced SI and GN amplitude when 

using an 81492A reference transmitter or generating 53GBd PAM4 signals. This behavior 

can be disabled or configured using “Debug Mode” (Configure (tab) > Stress receiver 

signal calibration) 

- Laser safety errors are sometimes returned when the reference transmitter is calibrated, 

and an external TLS source is used. As a workaround restart the test task or reduce the 

maximum output power of the tunable laser (“Maximum TLS output Power” parameter in 

the configure tab). 

- Stress signal calibration for 53GBd signals can only be carried out with SSPRQ pattern due 

to TDECQ stability reasons when using other shorter patterns (Configure (tab) > Stress 

receiver signal calibration > Calibration pattern).  

- The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure 

(tab) > Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to 

calibration failure.  

Keysight N4917BSCB Software Version 01.50.1000 

The following table lists the information that has changed from release v01.50.0000. For the 

complete set of support information, refer to Release V01.50.0000. 

Release Date: March 27, 2018 

File Name: SetupM80RxIEEE400G01501000.exe 

License: Please see the product data sheet on keysight.com  

 

Fixes 

- Fix for a problem with the AWG M8195A and M8196A firmware that caused an invalid 

AWG sampling frequency (error message: “Clock is out of range.”) for the external 

reference clock input.  

 

Keysight N4917BSCB Software Version 01.50.0000 

The following table lists the information that has changed from release v01.00.0000. For the 

complete set of support information, refer to Release V01.00.0000. 

Release Date: March 15, 2018 

Instrument Firmware 81600D DCA-X - FlexDCA version A.05.71 or later 

Software Pre-requisites: Keysight IO Library rev. 18.1 or above 

File Name: SetupM80RxIEEE400G01500000.exe 
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License: Please see the product data sheet on keysight.com  

 

Enhancements 

- Support for dual error detector (M8046A) configuration for all the receiver tests 

- Support for up to two clock data recovery modules as clock sources for receiver testing 

- Addition of two new utility functions: 

o Set PG transmission format 

o Set ED detection format 

- The “Optimize BERT deemphasis” utility function can be configured to run automatically 

before every Stressed Receiver Signal Calibration 

- Pauses in tests to enable manual settings before the error detector modules are aligned 

- Support for new configuration parameters: Maximum TLS Output Power, Use Offline Mode, 

Optimize deemphasis on calibration start, Pattern Generator Line Coding, Pattern 

Generator Data, Error Detector Line Coding, Error Detector Data Pattern, Error Detector 

Compare Mode, Error Detector Polarity, Error Detector (#1) Clock Source, Clock Data 

Recovery Module (ED #1), Error Detector (#2) Clock Source, and Clock Data Recovery 

Module (ED #2). 

- Better organization of configuration parameters in logical groups. 

- More comprehensive reporting of test results. 

 

Limitations 

- Limited support for the functionality of the “Upload Results to Repository” feature in the 

Test Application. 

- Limited support for remote control features. 

 

Known Issues 

- The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure 

(tab) > Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to 

calibration failure.  

- Stress signal calibration can only be carried out with SSPRQ pattern (Configure (tab) > 

Stress receiver signal calibration > Calibration pattern).  
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Keysight N4917BSCB Software Version 01.00.0000  

Release Date: December 6, 2017 

Operating System: Microsoft Windows 7 (64 bit)  

Microsoft Windows 8 (64 bit) 

Microsoft Windows 10 (64 bit) 

Memory 8 GB RAM [minimum] 

Display resolution: WXGA+ (1440 x 900) [minimum] 

PC Interfaces USB 

LAN 

GPIB (optional) 

Instrument Firmware M8040A BERT - M8070A System Software 

81600D DCA-X - FlexDCA version A.05.70.772 or 

later 

8164B LMS - Ver.V5.25 or later 

81490A Ref Tx - Ver.5.01 or later 

BERT M8040A-BU2 mainframe with USB option 

M8070A-0TP/ONP/1TP/1NP System Software 

M8045A-G32/0G3/0G4/0P3/801 High 

Performance BERT module 

M8057A Remote head for M8045A pattern 

generator, 1 channel 

M8046A-A32/0P3/801 Analyzer module 

Signal Generator for Sinusoidal and Gaussian Noise 

Interference 

M8195A-002/16G Arbitrary Waveform Generator or 

M8196A-002 Arbitrary Waveform Generator or 

Any other source that is SCPI code compatible with 

the Signal Generator listed above for setting 

frequency and output amplitude 

Signal Generator for System Clock You may optionally use system clock, if the internal 

clock of the BERT is not used. 

E8257D PSG Analog Signal Generator up to 67 

GHz or 

N5173B EXG X-series Microwave Analog Signal 

Generator up to 40 GHz or 

N5183B MXG X-series Microwave Analog Signal 

Generator up to 40 GHz or 

any other source that is SCPI code compatible with 

the Signal Generators listed above for setting 

frequency and output amplitude 
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Lightwave Measurement System 8164B LMS Mainframe 

Tunable lasers  

81602A-013 Tunable Laser 1250-1370 nm or 

81606A-113 Tunable Laser 1240-1380 nm or 

81608A-113 Tunable Laser 1240-1380 nm or 

81609A-113 Tunable Laser 1240-1380 nm 

 

Reference Transmitters 

81490A-E05 Reference Transmitter or  

81490A-E09 Reference Transmitter 

 

81000FI Optical Connector Interface 

81000NI Optical Connector Interface 

 

Optical attenuators:  

81576A Attenuator module (straight SMF) or 

81577A Attenuator module (angled SMF) or 

N7761A external Attenuator (1 ch straight SMF) or 

N7762A external Attenuator (2 ch straight SMF) or 

N7764A external Attenuator (4 ch straight SMF) 

N7751A external Attenuator (1 ch with 2 optical 

power meter channels, SMF) 

N7752A external Attenuator (2 ch with 2 optical 

power meter channels, SMF) 

DCA-X Oscilloscope 86100D-ETR/PTB/200/300 DCA-X mainframe 

 

86105D-281/IRC Electrical/Optical SMF module or 

86115D-282 /IRC Dual Optical SMF module 

 

86107A-020 Precision Time Base (not required, if 

DCA-X has the option –PTB) 

DCA-M Oscilloscope N1092A one optical channel or 

N1092B two optical channels or 

N1092C one optical, two electrical channels or 

N1092D four optical channels or 

N1092E two optical, two electrical channels 

options LOJ/PLK/IRC/200/300/500 
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Clock Recovery N1077A-232/SMS/JSA Optical/Electrical Clock 

Recovery 

N1076A-Electrical Clock Recovery 

Software Pre-requisites: Keysight IO Library rev. 17.2.20828 or above 

M8070A system software for M8000 series Ver. 

4.0.0 or later 

N1010A FlexDCA Remote Access System 

A.05.70.772 or later 

N1010A-9FP 

N1010A-TFP 

Application Requirements: Keysight M8070A System Software Version: 

4.0.100.2 and above with options 0TP 

Keysight M8045A with options G32 or G64; 03G or 

UG3; 0G4 or UG4; 0P3 or UP3 or 0P6 or UP6 

Keysight M8046A with options A32 or A64; 0P3 or 

UP3 

Keysight N4917BSCA 400G Optical Receiver Test 

Application  

N4917BSCA-1TP or N4917BSCA-1NP 

File Name: SetupM80RxIEEE400G01000000.exe 

 

Features 

First release of Keysight N4917BSCA 400G Optical Receiver Test Application. The application 

provides a platform for stressed receiver sensitivity test, which is compliant with automated 

standards for 200GBASE and 400GBASE Optical Receiver Stress Testing. The solution consists of 

several test instruments such as a Bit Error Rate Tester (BERT), an arbitrary waveform generator 

(AWG), Digital Sampling Scope (DCA), Optical Reference Transmitter, Tunable Laser, and Optical 

Attenuator operating together with the N4917BSCA software package. 

Some salient features of the N4917BSCA 400G Optical Receiver Test Application include: 

- Remote control of all the test instrumentation 

- Automated calibration of the optical stressed eye parameters (ER, SECQ, and OMA) 

following the procedure recommended by IEEE 

- Adjustable target values for ER, SECQ, and OMA 

- Automated Stress Receiver Sensitivity test 

- Automated jitter tolerance compliance and margin tests 
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Known Issues 

- Remote Interface feature (View > Preference > Remote) is not officially supported.  For 

instance, “Remote Interface Hint” (right click on “Tests” or “Utility Functions” in 

Select Tests” Tab) or the reference manual (Help > Automation > Remote Interface) are 

not final.  

- The validity range of the parameter “Sinusoidal Interferer to Noise Ratio” (Configure 

(tab) > Stress receiver signal calibration) is around 3 to 13 dB. Other values may lead to 

calibration failure.  

- Stress signal calibration can only be carried out with SSPRQ pattern (Configure (tab) > 

Stress receiver signal calibration > Calibration pattern).  

 

Please contact Keysight Technical Support (www.keysight.com/find/supportrequest) if you 

encounter any other issue. 

http://www.keysight.com/find/supportrequest
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